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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Chapter 1

Conventions Used in this Document
The following conventions are used in this document when referring to the location of files on the
HP Virtualization Performance Viewer (vPV) system.

Convention Description Value

<install_dir> The directory where vPV is installed. On Linux systems, the
installation directory is
/opt/OV.

<data_dir> The common data directory where data files
and log files related to HP Software products
are stored.

The data directory is
/var/opt/OV.
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Installation Overview
This chapter provides information about the following:

l Operating systems on which the current version of vPV is supported

Note: Only the x64-bit versions of all the operating systems are supported.

l Hardware and software components required to run vPV

l Components required for each operating environment

Before installing vPV, make sure you go through the "Installation Requirements".

vPV Installers
vPV is available in the following three forms:

l Linux-based installer

l Virtual appliance

l Archive Extractor

Note: The Archive Extractor version is available only for theWindows operating system
(x64-bit only). It is a free version and cannot be upgraded to a licensed version.

Installation Requirements
During installation, HP Software Installer performs the following tasks:

l Checks if your systemmeets the disk space requirements. For information on the disk space,
see "Hardware Requirements".

l Checks if your system has any other HP software product installed.

l Provides a detailed log of the system disk space and other HP software products detected.

l Provides a list of components installed.

Hardware Requirements
Theminimum hardware requirements for installing vPV are:

Item Value

CPU 2 vCPU
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Item Value

Memory 4GB

Disk 20GB

Installing on a slower system or one with less memory may result in slow performance.

Supported Browsers
The following table lists the web browsers that are required to access vPV:

Operating Systems Supported Browsers

Microsoft Windows Firefox 10 (ESR) and 16

Internet Explorer 8 and 9

Linux Firefox 10 (ESR) and 16

To view the vPV home page, install Adobe® Flash Player 10.2 or above and enable JavaScript
support for the Internet Explorer (IE) or Mozilla Firefox browser by adding vPV to your list of Trusted
Sites.

Support Matrix

The following table lists the support matrix for vPV.

Deliverable Platforms/Versions

Linux Installer RHEL 6.2, 6.3

CentOS 6.2

Virtual appliance CentOS 6.2

Installation Pre-requisites
Following are the prerequisites for installing vPV:

l vPV cannot co-exist with any other HP BTOSoftware product.

l If there is a firewall on the system where vPV is installed, ensure that port 8081 is open tomake
vPV accessible from the remote browser.

l To access in HTTPS mode, port 8444must be open.

l If there is a firewall between vPV andMicrosoft System Center Virtual MachineManager
(SCVMM) server, ensure that the port used for accessing vPV (8081 by default) is open in the
firewall.

l To access the Virtual ApplianceManagement Interface (VAMI), the port 5480must be opened.
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Linux-based Installer
Following are the prerequisites for the Installer version of vPV:

l Install Libvirt and all its dependencies on the vPV server.

Libvirt is an open sourcemanagement tool to manage virtualized platforms such as Linux, KVM,
Xen, and so on.

Libvirt can be installed on following versions of the different Linux flavors:

Linux Types OS Versions

CentOS 6.2

6.3

RHEL 6.2

6.3

l Install Expect and all its dependencies on the vPV server.

Expect is a tool that communicates with interactive programs such as ssh.

Archive Extractor
Following are the prerequisites for the Archive Extractor version of vPV:

l Java Runtime Environment (JRE) 1.6.0_35 and above

l Make sure that the environment variable JAVA_HOME or JRE_HOME is set

l Adobe Flash Player 10.2 or above
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Chapter 3

Installation Steps
The following section details the steps to install vPV:

l "Deploying the vPV Virtual Appliance"

l "Installing vPV"

l "Using the Archive Extractor"

Deploying the vPV Virtual Appliance
vPV is available as a Virtual Appliance for easy deployment in vCenter. You can use the VMware
vSphere Client user interface to deploy the virtual appliance.

The supported VMware vCenter Server versions are 4.1, 5, and 5.1.

To deploy the vPV virtual appliance, follow these steps:

1. Open VMware vSphere Client.

2. Type the credentials and click Login.

3. Select File > Deploy OVF Template. TheDeploy OVF Templatewindow opens.

4. Click Browse to browse to the location where you have saved the vPV virtual appliance file.

5. Click Next. The window shows the details of virtual appliance.

6. Click Next. The End User License Agreement details appear.

7. Click Accept and then click Next.

8. Type a name for the virtual appliance in theName field.

9. Select where to deploy the virtual appliance from the Inventory Location tree. Click Next.

10. Select the host or cluster where you want the virtual appliance to run. Click Next.

11. Select the specific host where to run the virtual appliance. Click Next.

12. Select the storage location where you want to store the virtual machine files. Click Next.

13. Select the disk format in which you want to store the virtual disks. Click Next.

14. Type the required Networking Properties and click Next. The window shows the details of the
deployment.

15. Select thePower on after deployment check box.

16. Click Finish. The deployment task starts. After deployment, the virtual appliance name
appears in the tree in the VMware vSphere Client user interface.

Note: Formore information, refer to the VMware documentation. The steps are subject to
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change based on VMware.

Installing vPV
You can install HP vPV on your Linux system by using any of the following procedures:

l "Attended Installation"

l "Unattended Installation"

Note: To install vPV on your system, youmust log on as root user.

Attended Installation
You can install HP vPV on your Linux systems throughGraphical and command line interfaces.

Installing HP vPV through Graphical Interface

To install vPV using X11 interface, perform the following tasks:

1. Login as a root user.

2. Place the HP vPV 1.10 CD/DVD-ROMmedia in the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. To start installation, if you want to use the X11 terminal window, export the DISPLAY variable
to point to an X11 terminal type the following command:

export DISPLAY=<IP_Address/system_name>:0.0

where, <IP_Address/system_name> is the IP address or the system name of the X11
terminal.

4. Type the following:

<CD/DVD-ROM> HPPV_1.xx.xxx_setup.bin

where, <CD/DVD-ROM> is the drive letter of the CD/DVD ROM.

The HP vPV Installation wizard appears. This window displays an introductory message.

Note: If you are installing HP vPV for the first-time on your Linux system, the
ovinstallparams.ini file containing the installation parameters is created in the
system’s temporary directory. During installation, HP Installer checks for the
ovinstallparams.ini file. If HP Installer detects the ovinstallparams.ini file
on your system, amessage asking if you want to reuse the values in the file appears.

n Click Yes to use the values in the configuration file as default values.

n Click No to overwrite the existing configuration file.
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If HP Installer does not find the file, the system creates the ovinstallparams.ini
file with default values in the temporary directory. To save the
ovinstallparams.ini data, copy the file to an alternate location, before installing
other HP products.

5. On the HP vPV Installation wizard, click Next. The License Agreement screen appears.

6. Read the terms of license agreement. To continue with installation, select I accept the terms
of License Agreement option. The installation wizard performs install checks.

7. Click Next. The Pre-Install Summary screen appears. The screen displays the list of
components that will be installed.

8. Click Install

Note: If the installation fails, you can roll back or quit installation. TheRoll Back option
removes the components which are already installed.

ClickingQuit stops the installation, but does not uninstall the components installed till
then.

When you start vPV installation next time, the Installer prompts you to confirm if you want
to resume the installation or uninstall vPV.

9. Click Details tab and expand the components tree to view the list of components.

10. To view the log file on your system, click View Log Files.

11. Click Done to complete the installation.

Note: If the system needs to be restarted, the followingmessage appears after installation
is complete: ‘Youmay need to restart your system for the configuration changes made to
the system to take effect. Would you like to quit this installation?’.

It is recommended that you restart your system after installation.

Installing HP vPV through Command Line Interface

Note: Localization is not supported when installing vPV in consolemode. As a result, some
text may be illegible.

To install vPV through Command Line interface:

1. Login as a root user.

2. Insert the HP vPV 1.10 CD/DVD-ROMmedia into the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. Run the following command:

If you are installing vPV on a stand-alone system:

<CD/DVDROM_mount>/HPPV_1.xx.xxx_setup.bin -i console
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where, <CD/DVD-ROM> is the drive letter of the CD/DVD ROM.

4. When the prompt, I accept the terms of the License Agreement for the License information
appears, typeY to accept the terms and continue installation. The installer checks all the
Install Requirements.

5. Click Enter to continue. The pre-installation summary appears.

6. Click Enter to continue.

When the installation is complete, you will receive amessage which states that the installation
was completed successfully.

Unattended Installation
To carry out unattended installation:

1. Login as a root user.

2. Insert the HP vPV 1.10 CD/DVD-ROMmedia into the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. Go to the directory where the CD/DVD-ROM is mounted.

4. Type the following syntax at the command prompt:

./HPPV_1.xx.xxx_setup.bin -i silent

Note: If the installer finds a working installation of HP vPV, it will uninstall HP vPV when
you run the -i silent command. If not, it will install vPV.

5. To verify the installation, check the log files.

Using the Archive Extractor
vPV is available as an Archive Extractor version (supported only onWindows) for quick download
and use.

To start using the Archive Extractor version, follow these steps:

1. Extract the contents of theHPPV_ArchiveExtractor_<version_number>.zip file to a folder.

2. Run the run.bat script .

To access the vPV user interface, open a browser and type the following URL:

http://<IP address/system name>:<port number>/PV

where, <IP address/system name> is the IP address or the system name of the vPV server and
<port number> is the port number of the vPV server.

Note: vPV does not support KVM, Xen, HP aPaaS, or OpenStack as data sources if it is
installed using the Archive Extractor.

To stop using the Archive Extractor version of vPV, run the stop.bat script.
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Installation Results
On successful installation:

l The Linux systems display the application directory and data directory paths.

l To view install log files see the following:

n For Linux: /tmp/HPPV_1.xx.xxx_HPPVInstaller.txt

/var/tmp/HPPVInstaller/PerfUtil-mm-dd-yyyy.log.0

In this instance, mm indicates themonth, dd indicates the day, and yyyy indicates the year. The
file name indicates the time stampwhen the install was performed.

Using vPV Commands
After you install vPV, you can use the following commands to administer the vPV workspace
through the command prompt.

<bin_dir>/pv <Options>

You can replace <Options> with any of the following variables:

l status - To check the vPV status.

l start - To start vPV.

All the applications that useOvTomcatB are started when you run pv start command.

l stop - To stop vPV.

All the applications that useOvTomcatB are stopped when you run pv stop command.

l restart - To stop and then start vPV.

l trace on - To start generating detailed trace files.

l trace off - To stop generating detailed trace files.

l version - To display the version of vPV installed on your system.

Configuring Security for vPV
You can configure security for vPV in the following ways:

l Restrict physical access to vPV - You need physical access to log on and perform activities.
You can configure vPV for additional system logon security.

l Restrict network access to vPV - You can restrict network access to vPV by using segregated
networks or firewall.

l Using secure communications - You can configure vPV to use Secure Sockets (HTTPS)
communication with the clients. For more information, see the following section.

HP Virtualization Performance Viewer (1.10)Page 15 of 28



Installation Guide
Chapter 3: Installation Steps

Using Secure Sockets Layer (SSL or HTTPS)
The HTTP and HTTPS protocols are by default enabled for vPV. The default port numbers for
HTTP and HTTPS are 8081 and 8444 respectively. You can choose to use either of the protocols.
However, to ensure security for administration-related tasks, youmust access vPV in the secure
communications mode. To access vPV in the securemode, use the following URL:

https://<systemname>:8444/PV

To access vPV in the non securemode, use the following URL:

http://<systemname>:8081/PV

You can also change the default port settings for both HTTP and HTTPS communications.

Changing Port Settings

The default HTTP port number to access vPV is 8081 and the default port number for secure
connection is 8444. All client systems are authorized to connect to vPV server. To change the
default port number for the vPV server, follow these steps:

1. Check for the availability of the port number you want to use, by running the following
commands at the command prompt:

cd <bin_dir>

ovtomcatbctl -checkport <portnumber>

A message indicating if the port is available or in use appears. For example, if you are checking
for the availability of the port number 8081, themessage, “Port Number 8081 is not in use”
appears, if the port number is available. If the Port Number 8081 is not available, a message
indicating that the port number is used by another program or service appears.

2. Stop vPV by running the following command at the command prompt:

ovpm stop

3. To change http or https port numbers for vPV server, run the following command at the
command prompt:

cd <bin_dir>

ovconfchg -ns NONOV.TomcatB -Set HTTPPort <port number>

ovconfchg -ns NONOV.TomcatB -Set HTTPSPort <port number>

4. Start the vPV server.

Disabling Secure Communications

To disable secure communications, perform the following steps:

1. Stop vPV, if vPV is running.

2. Run the following command at the command prompt:
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cd <bin_dir>

ovconfchg -ns NONOV.TomcatB -set EnableHTTPS False

Note: To enable secure communication again, set the value to True, instead of False, in
the preceding command.

3. Restart vPV.

Using SSL or HTTPS with the Tomcat Web Server

To use SSL or HTTPS protocols with the Tomcat web server, you need to obtain a server certificate
for Tomcat after installing vPV. You can replace the certificate obtained after vPV installation in the
following scenarios:

l When you connect to vPV using HTTPS protocol, the certificate and name of the system are
compared to ensure that the names match. If the names are not similar, most browsers alert the
users so that they can decide to either continue or cancel the connection. If the name used by
HTTPS users is different from the name used by the vPV installation, youmust obtain a different
certificate.

l Youmay need to obtain a new certificate when you want to fill the fields in the certificate that are
left blank during vPV installation. The certificate contains many fields to provide information,
such as, the issuer of the certificate and other fields that warrant the safety provided by the
certificate. The vPV installation certificate leaves most of these fields blank.

l When you want to change the default certificate password to avoid unauthorized changes, you
must replace the existing certificate.

To replace the Tomcat SSL certificate, perform the following steps:

1. Delete the existing certificate by running the following command at the command prompt.

keytool -delete -alias ovtomcatb -keystore /var/opt/OV/certificates/tomcat/b/tomcat.keystore

The keytool path on Linux is /opt/OV/nonOV/jre/b/bin

2. Restart vPV.

3. Create a new certificate. To create a new certificate, run Keytool by entering the following
commands at the command prompt:

keytool -genkey -alias ovtomcatb -keyalg RSA -keystore
/var/opt/OV/certificates/tomcat/b/tomcat.keystore

4. Restart vPV.
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License Management
After you install vPV, you can purchase the appropriate licenses based on your business
requirements. These licenses enable you to access all the features of the product.

To access the License tab on the vPV user interface:

1. Log in to the vPV user interface to import licenses.

2. Click in the Options pane to launch the Administration page from the vPV home page.

The LicenseManagement tab provides information about your vPV licenses. You can also use this
tab to start using your Evaluation License as well as import a Permanent vPV license. For more
information on importing licenses, see "Importing Licenses".

The different types of licenses available for vPV are as follows:

l Free: The product is free for you to use, but certain features are restricted.

l Evaluation: You can use the evaluation version of the product without any feature restrictions
for a period of 60 days. During this period, you can evaluate the product and upgrade to the
permanent licensed version of the product, if required.

l Permanent: You can use all the product features without any restrictions.

l Term: You can use all the product features without any restrictions. However, Term license is
valid for a defined subscription period.

The validity of the Term license starts on a date as per the order placed by the subscriber. These
licenses are locked to Subscriber ID. The capacity value is decided based on the subscription.

Note: If you install a permanent license on the vPV server which uses a free license, then the
free license expires.

If you want to retain the free license, create a separate vPV server to install the permanent
license.

For more information on the difference between the licenses and the features available, see "Types
of Licenses"

User Interface
The following table lists the sections available in the LicenseManagement tab.

Section Description

License Status Displays information regarding the installed licenses. The two tables available
are:
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Section Description

l Active License Details

l Installed Licenses

Manage
License

To import permanent licenses.

TheActive License Details table lists the following information about your current vPV License:

l Type of license installed

l Date of license expiry and number of days remaining until license expiry

l Number of instances that can bemonitored, based on the installed license

l Number of instances monitored currently

The Installed Licenses table lists the following information regarding the active and all installed
licenses for vPV:

l All active and installed licenses.

l Capacity or number of instances available corresponding to each license.

Note: The Installed Licenses table is not available when your current active license is Free
license.

Types of Licenses
The following table lists the available features for the Free, Evaluation, and Permanent vPV
Licenses.

Feature
Free
License Evaluation/Permanent/Term License

Number of Instances 200
instances

No limit

Data Retention Up to 24
hours

Default 30 days (customizable data retention and
aggregation policy)

LDAP Authentication/Multi-
user support

Not
Available

Available

Reports Not
Available

Available

PM and BSM Integration Not
Available

Available

Note: The number of instances denote only the VMs and hosts.
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All product features are available for the Evaluation License. The only difference between the
Evaluation License and Permanent License is the validity.

The Archive Extractor version of vPV is available only as a free version for ease of use and you
cannot upgrade it to a licensed version.

Instances

The following table lists the types of instances supported by each data sources:

Data Sources
Supported Instance
Type

VMware vCenter l VMs

l Hosts

Microsoft SCVMM l VMs

l Hosts

KVM l VMs

l Hosts

Xen l VMs

l Hosts

OpenStack l VMs

Evaluation License
After installing vPV, by default, your active license will be Free License. To start using your
Evaluation License, click Start Evaluation. The page refreshes and displays information regarding
your Evaluation License.

After the Evaluation License expires (after 60 days), the system changes your license
automatically to Free License.

License Validity

The following table lists the validity of the different vPV licenses.

License Validity

Free Not Applicable

Evaluation 60 days

Permanent Not Applicable

Term Depends on the date that the license is ordered.

Note: Free and Permanent Licenses do not expire.
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Importing Licenses
After you purchase a license, youmust import it before you start using vPV.

To import permanent licenses for vPV, follow these steps:

1. Go to the License Management tab in Administration page.

2. Type your license key in the License Key field of theManage License section.

3. Click Import License. The License Status section refreshes to display the details of the
license imported.

To clear the license key typed in, click Reset.
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Removing HP vPV
You can remove vPV installed on Linux systems by using the procedure described in the following
section:

Removing the vPV Virtual Appliance
To remove the vPV virtual appliance, power off the VM and delete the VM.

Uninstalling vPV on Linux
To remove vPV from a Linux system:

1. Log on as root user.

2. Go to /opt/OV/Uninstall/HPPV.

3. Run the uninstall command:

n To use an X11 interface, export the DISPLAY variable to point to an X11 terminal if
necessary. Then run the command:

./setup.bin

n To use a command line interface, run the command:

./setup.bin -i console

4. Select Uninstall.

Removing configurations and User Graph Templates
Removing vPV does not remove configurations or user graph templates. You need tomanually
remove the files from the data directory.

Removing vPV Files using the Clean-up Script
After removing vPV, youmust run the following clean-up script. This script is available in the
<install_dir>\support:

l clnup_pv.sh for Linux

The clean-up script removes the following files from <data_dir>\conf\perf:

l OVPMconfig.ini

l OVPMUsers.xml

l OVPMSystems.xml

HP Virtualization Performance Viewer (1.10)Page 23 of 28



Installation Guide
Chapter 5: Removing HP vPV

l ovpm.tcf

l VPI_GraphsUserFavorites.txt

l OVPMReportTemplate.htm

l All folders starting with the name "VPI_".

l All PV database related files

Note: If you plan to reinstall vPV on the same system, make sure you delete the following
folders after you finish running the clean-up script:

l /opt/OV/

l /opt/vertica/

l /var/opt/OV/
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Troubleshooting vPV
The following section details how to troubleshoot vPV:

Vertica database is filled to near capacity due to the increase in the log file size.

Symptom The Vertica database is filled to near capacity due to the increase in the log file size.

Causes Vertice database consolidates and retains the log data in a .gz file daily. By default,
this process (called ‘rotate’) continues for 52 weeks.

Resolution To createmore space on the Vertica database implement any one of the two
solutions below.

Solution 1

1. Go to /opt/vertica/config/logrotate/.

2. Open the pv file.

3. In the pv file, under # and keep for 52 weeks change the value of rotate from
52 to the number of weeks for which you want to save the rotated log files.

For example: rotate 3

In this instance, the Vertica database will retain the .gz files for 3 weeks.

4. Repeat step 3 for all instances of # and keep for 52 weeks.

5. Save and close the file.

Solution 2

1. Login as a root user.

2. Run the following commands on the vPV server:

cd /opt/vertica/bin

./admintools -t logrotate -d pv -r weekly -k <number_of_
weeks>

where, <number_of_weeks> is the number of weeks for which you want to
retain the rotated logs.

Unable to Access vPV

Symptom Unable to access vPV through the default network port settings.

Causes l Your system has ovTomcatB configured to run with the non-root user or non-
local system account privileges and you have vPV installed on such a system.

l You cannot access vPV using the default http (8081) or https (8444) ports if
these ports are in use by other applications.
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Resolution l Check if ovTomcatB is configured to run with the non-root user or non-local
system account privileges. If so, modify the settings to run ovTomcatB with the
Administrator or root user privileges.

l Try accessing vPV by using the following URL:

http://<IP address/system name>:<port number>/PV

where, <IP address/system name> is the IP address or the system name of the
vPV server and <port number> is the port number of the vPV server.

If the vPV Home page does not appear, check if the default ports are in use.

l To change the port settings, follow these steps:

1. Run the following command at the command prompt to change the port
numbers for HTTP, HTTPS, and ShutdownPorts:
<bin_dir>ovconfchg -ns NONOV.TomcatB -set HTTPPort <port number>

<bin_dir>ovconfchg -ns NONOV.TomcatB -set HTTPSPort <port number>

<bin_dir>ovconfchg -ns NONOV.TomcatB -set ShutdownPort <port number>

2. Restart vPV.

Unable to connect to vPV server through HTTPS protocol

Symptom vPV is unable to connect to the server through secure communication (HTTPS)
protocol.

Cause The connection times out when vPV is not able to connect through the secure client
in the default timeout interval of one second.

Resolution Use the parameterSECURE_CLIENT_CONNECT_TIMEOUT to adjust the
timeout interval to connect to vPV server depending on your Internet connectivity
or infrastructure setup.

Deployment of vPV fails

Symptom The deployment of the vPV Virtual Appliance fails.

Cause This may happen when the time on the ESX server is set to a future time.

Resolution Ensure that the time on the ESX server is set correctly.

Unable to view content on vPV home page

Symptom The vPV Home page does not display anything except the header.

Cause Javascript is not supported or Adobe® Flash Player is not installed in your browser.
Adobe® Flash Player version 10.3 is theminimum required version.

Resolution Install Adobe® Flash Player and enable JavaScript support for the Internet Explorer
(IE) or Mozilla Firefox browser by adding vPV to your list of Trusted Sites.
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l To add vPVWeb server URL to a trusted site, perform the following steps:

For IE browser

a. From the Tools menu, click Internet Options. The Internet Options pop-up
appears.

b. Click Security tab.

c. Select the Trusted Sites icon.

d. Click Sites. The Trusted Sites pop-up appears.

e. Type the vPV web server URL and click Add. The typed URL appears in the
list of trusted sites.

f. Click Close.

g. Click OK.

h. Restart the browser.

For Mozilla Firefox browser

a. From the Edit menu, click Preferences. TheOptions pop-up appears.

b. Click Privacy tab.

c. Click Exceptions.

d. Type the vPV web server URL in the box under Address of web site.

e. Click Allow.

f. Click Close.

g. Click OK.

h. Restart the browser.

l If Adobe® Flash Player is not installed in your browser, vPV Home page does not
appear. The browser displays amessage stating that youmust Install Adobe
Flash Player to view the vPV HomePage. Click themessage to download
Adobe® Flash Player.

l If Javascript is not enabled in your browser, vPV Home page does not appear in
the IE browser even after adding it as a trusted site. The browser displays a
message stating that Javascript is not enabled in your browser and youmust
enable Javascript to view the page.

To enable Javascript support, perform the following steps:

For IE browser

a. From the Tools menu, click Internet Options. The Internet Options pop-up
appears.
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b. Click theSecurity tab. Check if the security level in your browser settings is
set to High.

c. Make sure the Trusted Sites icon is selected and click Custom Level. The
Security Settings pop-up appears.

d. Scroll down to Scripting section and select theEnabled option underActive
Scripting.

e. Click OK.

f. Click Apply.

For Mozilla Firefox browser:

a. From the Tools menu, click Options.

b. Click Content..

c. Select theEnable JavaScript check box.

d. Click OK.

HTTP Status 404 - /PV Error

Symptom When trying to access vPV, you get the HTTP Status 404 - /PV Error message.

Cause Themessage appears if the <INSTALLDIR>/www/webapps/PV directory is empty.

Resolution Extract the Perf.war file again from <Install_Dir>/newconfig/PV to <Install_
dir>/www/webapps/PV. Run the command pv deploywar.
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